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Introduction
JasperReports® Server builds on JasperReports® Library as a comprehensive family of
Business Intelligence (BI) products, providing robust static and interactive reporting, report
server, and data analysis capabilities. These capabilities are available as either stand-alone
products, or as part of an integrated end-to-end BI suite utilizing common metadata and
provide shared services, such as security, a repository, and scheduling. The server exposes
comprehensive public interfaces enabling seamless integration with other applications and
the capability to easily add custom functionality.

This section describes functionality that can be restricted by the software license for JasperReports
Server. If you do not see some of the options described in this section, your license may prohibit
you from using them. To find out what you are licensed to use, or to upgrade your license, contact
Jaspersoft.

The heart of the Jaspersoft® BI Suite is the server, which provides the ability to:

• Easily create new reports based on views designed in an intuitive, web-based, drag
and drop Ad Hoc Editor.

• Efficiently and securely manage many reports.

• Interact with reports, including sorting, changing formatting, entering parameters,
and drilling on data.

• Schedule reports for distribution through email and storage in the repository.

• Arrange reports and web content to create appealing, data-rich Jaspersoft
Dashboards that quickly convey business trends.

For users interested in multi-dimensional modeling, we offer Jaspersoft® OLAP, which runs
as part of the server.

While the Ad Hoc Editor lets users create simple reports, more complex reports can be
created outside of the server. You can either use Jaspersoft® Studio or manually write
JRXML code to create a report that can be run in the server. We recommend that you use
Jaspersoft Studio unless you have a thorough understanding of the JasperReports file
structure.

You can use the following sources of information to learn about JasperReports Server:
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• Our core documentation describes how to install, administer, and use JasperReports
Server and Jaspersoft Studio. Core documentation is available as PDFs in the doc
subdirectory of your JasperReports Server installation. You can also access PDF and
HTML versions of these guides online from the Documentation section of the
Jaspersoft Community website.

• Our Ultimate Guides document advanced features and configuration. They also
include best practice recommendations and numerous examples. You can access
PDF and HTML versions of these guides online from the Documentation section of
the Jaspersoft Community website.

• The Jaspersoft Community website covers topics for developers, system
administrators, business users, and data integration users.

• Our free samples, which are installed with JasperReports Library, Jaspersoft Studio,
and JasperReports Server, are available and documented online. Please visit our
GitHub repository.

• If you have a subscription to our professional support offerings, please contact our
Technical Support team when you have questions or run into difficulties. They're
available on the web at https://www.jaspersoft.com/support.

JasperReports Server is a component of both a community project and commercial
offerings. Each integrates the standard features such as security, scheduling, a web services
interface, and much more for running and sharing reports. Commercial editions provide
additional features, including Ad Hoc views and reports, advanced charts, dashboards,
Domains, auditing, and a multi-organization architecture for hosting large BI deployments.

http://community.jaspersoft.com/documentation
http://community.jaspersoft.com/documentation
https://community.jaspersoft.com/
https://github.com/Jaspersoft/jasperreports
https://www.jaspersoft.com/support
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Installation and Configuration
This document covers Jaspersoft for AWS Hourly and Annual Offerings as well as Jaspersoft
for AWS BYOL (Bring Your Own License) and Jaspersoft for AWS with Multi-Tenancy. You
can purchase the hourly and annual products directly on the AWS Marketplace. To
purchase annual subscription licenses for BYOL contact Jaspersoft Sales.

Jaspersoft also offers a Quick Start for deploying JasperReports Server on AWS. Quick Starts are
automated reference deployments that use AWS CloudFormation templates to deploy key
technologies on AWS, following AWS best practices. See the deployment guide for JasperReports
Server on the AWS Cloud for more information.

This chapter assumes you have basic knowledge of JasperReports Server. You can find
Jaspersoft’s documentation on the Jaspersoft Community Site:
http://community.jaspersoft.com/documentation.

This chapter contains the following sections:

• Prerequisites

• Subscribing From AWS Marketplace

• Launching Instances

• Using Customized Configuration Files for Server Instances

• Configuring HTTPS Access for AWS ELB and JasperReports Server

• Chrome/Chromium for AWS

Prerequisites
You need a few things before you can install and run Jaspersoft Business Intelligence on
Amazon Web Services:

• An Amazon Web Services (AWS) account.

If you already have an account, log into AWS.

https://aws.amazon.com/quickstart/architecture/tibco-jaspersoft/
https://aws.amazon.com/quickstart/architecture/tibco-jaspersoft/
http://community.jaspersoft.com/documentation
http://aws.amazon.com/
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To create an AWS account, go to the Amazon Web Services sign up page, select My
Account > AWS Management Console, then click Create a new AWS account and
follow the instructions.

If you have a personal Amazon.com account stored in your browser, AWS uses that account by
default. You need to sign out of Amazon or, preferably, use a different browser to set up an AWS
account separate from your personal account.

• A valid Amazon key pair in your account. If you do not have a valid key pair, follow
the instructions on the AWS documentation site:
https://docs.aws.amazon.com/AWSEC2/latest/UserGuide/ec2-key-pairs.html

• The Required Permissions for using our CloudFormation templates and connecting
to a data source

• If you plan to use Jaspersoft for AWS BYOL, you need an annual subscription license.
To purchase licenses for BYOL contact Jaspersoft Sales

The procedures in this section work for both Jaspersoft Reporting and Analytics for AWS (Hourly
and BYOL) for AWS and Jaspersoft for AWS with MultiTenancy.

Required Permissions
Depending on how you use Jaspersoft for AWS, you need various permission sets.

Using our CloudFormation (CF) templates

Using our CF templates typically requires some admin permissions. AWS permissions
required to launch a new JasperReports Server instance include:

• CloudFormation create stack and events

• Create and run EC2 instances

• Create EC2 security groups

• Create IAM resources

AWS permissions required to launch the template to create a JasperReports Server role or
user include:

• Create IAM resources

• Grant access to RDS, Redshift, and EC2

http://aws.amazon.com/
https://docs.aws.amazon.com/AWSEC2/latest/UserGuide/ec2-key-pairs.html
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Connecting to the data source

Permissions required to connect to the data source include:

• Access to RDS and/or Redshift

• Permissions to create and modify the database security groups in each

• Permissions to create and modify EC2 security groups

Please note that this document does not address connectivity to Amazon Elastic
MapReduce (EMR).

Subscribing From AWS Marketplace
The Jaspersoft listing on the AWS Marketplace offers multiple Jaspersoft Reporting and
Analytics products as subscriptions:

• Jaspersoft Reporting and Analytics for AWS (Hourly)

• Jaspersoft for AWS with Multi-Tenancy (Hourly)

• Jaspersoft Reporting and Analytics for AWS (BYOL)

Subscribing to a Jaspersoft product is a single process with multiple steps, which includes
accepting the terms of use for both the AWS Marketplace and Jaspersoft.

The product page shows the pricing information (hourly and annual for non-BYOL),
available instance types, and support information for the Jaspersoft product.

The product page shows the total projected charges hourly or annually plus EC2 infrastructure
charges but you get charged until you subscribe. Simply visiting a page does not place your order.

Click Continue to Subscribe to start the AWS Marketplace subscription process. Log in to
your AWS account if you are not already logged in. When prompted, read and accept the
terms of use.

On the product page, from the Actions dropdown list select Launch CloudFormation
stack. On the Configure this software page, select how the product is deployed
(Fulfillment Option), the version of the software, your region, the type of JasperReports
Server instance, and the number of licenses.

You may receive an email confirmation once your order is processed.

https://aws.amazon.com/marketplace/search/results/ref=sp_navgno_search_box?page=1&searchTerms=jaspersoft
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Launching Instances
This section describes the processes for creating a JasperReports Server instance or cluster
inside a Virtual Private Cloud (VPC).

Your Jaspersoft software is charged separately from the AWS EC2 instance charges. Please
make sure you follow these instructions to turn off your EC2 instance server running Jaspersoft
after use. If not, you continue to be charged by the hour for EC2 use. Note that when you stop
your EC2 instance server no one has access to the reports or dashboards you have created until
you restart the EC2 instance server. When you stop an EC2 instance server, you can still be
charged the small EBS charge. If you do not want to be charged for EBS, make sure you
terminate your EC2 instance server. Note that in this case none of your work can be retrievable
unless you are using an auto-scaling cluster.

Creating a JasperReports Server Instance in a VPC
The JasperReports Server instance is hosted in your Virtual Private Cloud (VPC).

To create a JasperReports Server instance in a VPC

1. Select the Jaspersoft product that you want in the AWS Marketplace and follow the
subscription process to get to the Configure the Software page.

2. Under the Fulfillment Option, select CloudFormation Template from the first
dropdown list.

3. From the second dropdown list, select the option specific to the Jaspersoft product:

• Jaspersoft Instance in a VPC for Jaspersoft Reporting and Analytics for AWS
(Hourly)

• Jaspersoft Multi-tenancy Instance in a VPC for Jaspersoft for AWS with Multi-
Tenancy (Hourly)

• BYOL Jaspersoft Stack VPC deployment for Jaspersoft Reporting and Analytics
for AWS (BYOL)

4. Select the software version and region, then click Continue to Launch.

5. Under Choose Action, select Launch CloudFormation and then click Launch. The
Create stack page in the AWS console opens. Under the Specify template, the
Amazon S3 URL option is already selected and a URL for the template file is filled in.
Do not change these options.

http://docs.aws.amazon.com/AWSEC2/latest/UserGuide/Stop_Start.html
http://aws.amazon.com/ebs/
http://docs.aws.amazon.com/AWSEC2/latest/UserGuide/terminating-instances.html
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6. Click Next. The Specify stack details page appears.

7. In the Stack name field, give your CloudFormation stack a unique name.

8. Choose an InstanceType.

9. Choose the KeyPairName of your EC2 KeyPair.

10.Choose the VpcId from your account.

11.Choose the SubnetId from the VPC.

12.Choose whether to create a publicly accessible IP address for the instance using
EnablePublicIp. Default is True. Select False to refuse.

13. In the RemoteAccessCIDR field, enter the IP address and mask for SSH access.

14.Click Next. The Configure stack options page appears.

15.Add any tags that you want to use to simplify the administration of your
infrastructure.

A tag consists of a key/value pair and can flow to resources inside your stack. You
can add up to 10 unique keys to each instance, along with an optional value for
each key.

16.Select an IAM role for managing the stack's resources.

17.Expand the Advanced section and set your notification, rollback, and other options.

18.Click Next. The Review page appears.

19.Double check your template, parameter, and option information.

20.Click the acknowledgment checkbox, then click Create Stack. You see a message
telling you your stack has been created. The Services web page shows your stack's
initial status as CREATE_IN_PROGRESS. It generally takes two to four minutes for the
status to change to CREATE_COMPLETE.

21.Select your complete instance and click the Outputs tab. Here you can find the
information you need when you are ready to log into JasperReports Server:

• The URL for Getting Started with JasperReports Server.

• The name of your instance.

• The login name and password.

• The name of your S3LicenseBucket.
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Creating a JasperReports Server Cluster Inside a
VPC
Jaspersoft provides an auto-scaling cluster using the Amazon Relational Database Service
(RDS) that ensures that there are enough EC2 instances to handle the workload for your
JasperReports Server application. With the cluster, instances are created and removed
depending on CPU usage. It also provides a failover mechanism by storing your repository
in an external database, so if something happens to an instance it can be replaced and
connected to your existing repository. The cluster uses the Amazon Elastic Load Balancer
(ELB) to route traffic and only supports PostgreSQL databases. You need to create and
initialize your PostgreSQL database and make sure that it is in the same VPC where the
JasperReports® Server stack is created.

The CloudFormation template for the cluster creates the following AWS resources:

• An Auto Scaling group that contains the EC2 instances for your JasperReports Server
cluster. When creating the stack, you can define the maximum number of instances
in your cluster. The Auto Scaling group defines the thresholds for increasing and
decreasing the instances in your cluster. For more information about auto scaling
groups, see the AWS documentation:

https://docs.aws.amazon.com/autoscaling/latest/userguide/AutoScalingGroup.html

• An Amazon ELB that works as a static endpoint (DNS Name - URL) and monitors the
clustered JasperReports Server instances. If something happens to one of your
instances—the instance fails or JasperReports Server stops responding—it can be
replaced with a new one. For more information on ELB, see the AWS documentation:
https://docs.aws.amazon.com/elasticloadbalancing/latest/application/introduction.h
tml

If you are using a BYOL license, make sure to delete any existing instances after applying your
license. Deleting an instance before applying for your license may result in the automatic creation
of a new instance using an older license. See Applying a Jaspersoft License for AWS BYOL for
more information.

To create a new JasperReports Server cluster in a VPC

1. Select the Jaspersoft product that you want in the AWS Marketplace and follow the
subscription process to get to the Configure the Software page.

2. Under the Fulfillment Option, select CloudFormation Template from the first
dropdown list.

https://docs.aws.amazon.com/autoscaling/latest/userguide/AutoScalingGroup.html
https://docs.aws.amazon.com/elasticloadbalancing/latest/application/introduction.html
https://docs.aws.amazon.com/elasticloadbalancing/latest/application/introduction.html
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3. From the second dropdown list, select the option specific to the Jaspersoft product:

• JasperReports Server (Hourly) cluster for Jaspersoft Reporting and Analytics
for AWS (Hourly)

• JasperReports Server MT Hourly cluster for Jaspersoft for AWS with Multi-
Tenancy (Hourly)

• Jaspersoft BYOL Cluster for Jaspersoft Reporting and Analytics for AWS (BYOL)

4. Select the software version and region, then click Continue to Launch.

5. Under Choose Action, select Launch CloudFormation and then click Launch. The
Create stack page in the AWS console opens. Under the Specify template, the
Amazon S3 URL option is already selected and a URL for the template file is filled in.
Do not change these options.

6. Click Next. The Specify stack details page appears.

7. In the Stack name field, give your CloudFormation stack a unique name.

8. Enter the host name of your database connection in DBHost, the database port
number in DBPort, and the database name in DBName.

9. Enter the database username in the DBUser field and the database password in
DBPassword.

10.Choose an InstanceType.

11.Choose the KeyPairName of your EC2 KeyPair.

12.Choose your VpcId from the dropdowns.

13.Choose at least two LoadBalancerSubnetIds from the same VPC.

Selecting two SubnetIds from the different VPCs generate an error.

14.EnablePublicIp defaults to true. Unless you change this setting, your initialization
instance can be assigned a public IP address and an ELB (if enabled) can be
configured as "internet-facing". See Amazon's documentation about internet-facing
load balancers here:

http://docs.aws.amazon.com/ElasticLoadBalancing/latest/DeveloperGuide/elb-
internet-facing-load-balancers.html

15. In the SecuredIp field, enter the IP address and mask for SSH access.

http://docs.aws.amazon.com/ElasticLoadBalancing/latest/DeveloperGuide/elb-internet-facing-load-balancers.html
http://docs.aws.amazon.com/ElasticLoadBalancing/latest/DeveloperGuide/elb-internet-facing-load-balancers.html
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16.Enter the maximum number of instances to create for your cluster in the
MaxInstancesCount field. You can have a maximum of 10 instances in your cluster.

17.Select your AvailabilityZones from the dropdown.

18.To enable notifications about your instance state, enter a valid email address in the
OperatorEMail field. Leave this field blank to disable the notification.

19.Click Next. The Configure stack options page appears.

20.Add any tags that you want to simplify the administration of your infrastructure.

A tag consists of a key/value pair and can flow to resources inside your stack. You
can add up to 10 unique tags for each instance.

21.Expand the Advanced section of the Configure stack options page and set your
notification, rollback, and other options.

22.Click Next. The Review page appears.

Double-check your template, parameter, and option information.

23.Click the acknowledgment checkbox, then click Create.

You can see your Stack Name listed in a table. While it is being created the Status
column can display CREATE_IN_PROGRESS. After a few minutes, the status should
change to CREATE_COMPLETE.

If the status changes to ROLLBACK instead of CREATE_COMPLETE, you need to
accept the Terms of Use. Check the Events tab for more information.

24.Select your complete instance and click the Outputs tab. Here you can find the
information you need when you are ready to log into JasperReports Server:

• The URL for Getting Started with JasperReports Server.

• The login name and password.

• The name of your ProvisionInstance.

• The name of your Auto Scaling group.

• The name of your S3LicenseBucket.

Initializing Repository
Manually create a new Repository database in an external PostgreSQL database and
initialize it.
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If a database connection issue occurs, make sure that the instance's public and private IP
addresses are accessible to RDS.

To initialize the repository

1. Log in to your instance by ssh using the ssh -i EC2_KeyPair ec2-user@instance_name
command.

You can find the instance name on the Outputs tab. See Amazon's documentation
for more information on connecting to the instance:

http://docs.aws.amazon.com/AWSEC2/latest/UserGuide/AccessingInstances.html

2. Change the directory to:

/usr/share/jrs_dist/jasperreports-server-bin

3. Run the initialization script:

sudo -E ./deploy-database-to-external-repo.sh normal if you want to create the
sugarcrm and foodmart sample databases or sudo -E ./deploy-database-to-external-
repo.sh minimal if you do not want those databases.

You may want to skip the initialization script if your external database already contains a valid
JasperReports Server repository that you want to use. The script can create (or recreate) a
JasperReports Server repository database (for example from a previous dump or RDS
snapshot) with a minimal set of resources or with samples.

4. If initialization is successful, halt the instance: sudo halt -p

If initialization is unsuccessful, troubleshoot the database, then run the initialization
script (step 3).

5. Go to the EC2 Console and increase the instance count from 0 to 1 in the Auto
Scaling group (the name is provided on the Outputs tab of the CloudFormation
template).

6. Use the Getting Started URL from the Outputs tab to access your JasperReports
Server appliance.

Creating a JasperReports Server Instance from the
EC2 Console
If you have a complex network topology or special volume requirements, you might need
to create your instance from the EC2 Console.

http://docs.aws.amazon.com/AWSEC2/latest/UserGuide/AccessingInstances.html
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Before you can create a JasperReports Server instance from the EC2 console, you need to
create a CloudFormation role. If you skip this step, when you get to the Welcome screen,
you can see the following error message:

We do not recommend this method, because it does not provide the auto-connection
feature for Amazon RDS and Redshift included with the CloudFormation templates. If you
choose this method, be sure to define that option during the setup process.

Figure 1: Missing Role Error Message

If you launch your instance with a role, JasperReports Server use that Role to generate
temporary AWS security tokens for automatic discovery and management of security
between your JasperReports Server instance and RDS\Redshift instances.

If no role is defined in your JasperReports Server Instance, you have 2 options:

• Provide Access and Secret keys in AWS Datasource for Discovery and Automatic
Security management.

• Manage security manually. (In this case, remember to disable Automatic security
management in JasperReports Server Server Settings.)

To create a JasperReports Server instance from the EC2 console

1. Open the AWS Management Console.

2. Go to Compute > EC2. The EC2 Dashboard page opens.

3. On the left, select Image > AMIs.

4. Enter Jaspersoft in the Search text field and press Enter.

5. Select the AMI that you want, and click the Launch button at the top of the page.
The Choose an Instance Type page opens.

Make sure you select the correct AMI for your license type (hourly, annual, or BYOL).
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6. Choose an Instance Type from the list.

Figure 2: Instance Type list

7. Click Next: Configure Instance Details at the bottom of the page, and configure the

following details. Hover over the information icon for descriptions of each item.

• Number of instances

• Purchasing option

• Network

• Availability Zone (if using EC2) or Subnet (if using VPC)

• Auto-assign Public IP

• IAM role

• Shutdown behavior

• Enable termination protection

• Monitoring

• Tenancy

8. Expand the Advanced Details section and configure the following details:

• Kernel ID

• RAM disk ID
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• User data

9. Click Next: Add Storage and review the details. Click the items that you want to edit.
You can add EBS and instance store volumes by clicking the Add New Volume
button.

10.Click Next: Tag Instance and add optional tags. To add more tags, click the Create
Tag button.

A tag is a key/value pair that flows to resources inside your stack. You can add up to
10 unique tags to each instance.

11.Click Next: Configure Security Group and configure your firewall rules. Choose an
existing security group or create a new security group.

We set up one AWS DB Security Group (using IP address) per JasperReports Server instance
in each RDS region. The security group allows connections from the JasperReports Server
instance to the specified AWS database instance.

12.Click Review and Launch. Review your information and edit if necessary.

13.Click Launch.

14.When prompted, select an existing key pair, or create a new key pair, and click
Launch Instances.

You can see a message telling you that your instance is now launching. Your
instances may take a few minutes to launch, depending on the software you are
running.

Hours of use on your new instances start immediately and continue to accrue until you stop or
terminate your instances.

15.Click Close.

Logging in to JasperReports Server
Log into JasperReports Server using the Getting Started URL generated when you created
your JasperReports Server instance. You can find this URL in the Cloud Formation Outputs
tab.

The initial user is superuser and the password is your AWS instance ID. Located below the
Getting Started URL in the Outputs tab or in the EC2 console. You can change the password
after your initial login.
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To log into JasperReports Server the first time

1. Click the GettingStartedURL link in your Outputs tab. The Welcome to Jaspersoft BI
page appears.

Figure 3: Welcome to Jaspersoft BI page

2. Choose what you want from the following:

• Upload your license to the server

• Explore resources

• Watch an introductory video

• Log in
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Figure 4: Login Screen

If you are using BYOL, you can start with a 60 days license. This page displays a reminder
when your license is set to expire.

Before you click the Login button on this page

1. Enter superuser as your User ID.

2. Your AWS EC2 instance ID is your initial password.

You can find your AWS instance ID on the CloudFormation Outputs tab of your
instance or in the EC2 console.
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Figure 5: Finding the default password in the CloudFormation stack

Figure 6: Finding the default password in the EC2 console.

3. Click Change password and enter a new password.
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4. Log in again. The Home screen appears.

Figure 7: Home Screen

If you use PostgreSQL as your database, not all PostgreSQL-supported functions work with
Redshift. See the Redshift documentation for details about supported functions.

Using Customized Configuration Files for Server
Instances
JasperReports Server allows you to use the S3 bucket for your CloudFormation stack to
store customized configuration files for creating your EC2 instances. Uploading the
configuration files to the S3 bucket apply the customizations to every instance created
from the stack, including instances created as part of a cluster. In the S3 bucket, you must
recreate the JasperReports Server structure for the configuration files, starting with the
conf and webapp folders at the Tomcat root level.
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If you want to remove the customized file from an EC2 instance, you need to copy the original
configuration file to the S3 bucket and reboot the instance. This replaces the file on the instance
and remove the customizations from JasperReports Server. Deleting the customized file from the
S3 bucket without adding a replacement cannot remove the customizations when the instance is
rebooted.

To upload your customization

1. On the AWS Management Console homepage, click CloudFormation.

2. Click the name of the CloudFormation stack for your cluster.

3. Find the name of the stack's S3 bucket on the Outputs tab.

4. Return to the AWS Management Console homepage and click S3.

5. Find the bucket for your cluster and click the name.

6. Click Create Folder. Recreate the paths to your configuration files starting with the
conf and webapp folders.

7. After creating the folder paths, browse to the folder for your configuration file.

8. Click Upload.

9. Click Add files and find the configuration file on your local machine.

10.Click Upload to upload the configuration file.

AWS uploads the file and stores it in the S3 bucket.

11.With the configuration file in place, reboot or terminate the cluster from the EC2 >
Instances > Instances page.

When the cluster is rebooted or recreated, the changes based on the configuration
file can be in place.

Configuring HTTPS Access for AWS ELB and
JasperReports Server
Follow these instructions if you want to use Elastic Load Balancer (ELB) as an
HTTPS termination point with JasperReports Server behind it.

1. Create your ELB in AWS with a JasperReports Server instance behind it.

2. Configure your load balancer using the instructions found here:
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https://docs.aws.amazon.com/elasticloadbalancing/latest/application/introduction.h
tml

3. Edit the following file in your JasperReports Server instance:

/usr/share/tomcat/conf/server.xml

a. Locate the connector tag: <connector port="80"...

b. In the connector tag, add the following parameters:

scheme="https" proxyPort="443" proxyName="Elastic load balancer public DNS
name"

4. Save the file and restart tomcat. See Stopping and Restarting Tomcat.

Chrome/Chromium for AWS
JasperReports Server uses the Chromium JavaScript engine to generate graphical reports
that are run in the background or scheduled and to export dashboards to PDF and other
output formats. You can use Chrome, Chromium, or any other browser based on Chromium
like Microsoft Edge.

For more information about Chrome/Chromium in JasperReports Server, see the
JasperReports Server Administrator Guide.

GovCloud Instances
This section describes the processes for creating a JasperReports Server BYOL instance or
cluster inside a Virtual Private Cloud (VPC) on GovCloud. GovCloud instances are displayed
when the user selects the JasperReports Server BYOL offering.

To create a new Gov Cloud instance in a VPC

1. On the AWS Marketplace page, under the Get started section, click Manage
subscriptions. Manage subscriptions page appears.

2. Select a Jaspersoft Reporting and Analytics for AWS (BYOL) subscription. Jaspersoft
Reporting and Analytics for AWS (BYOL) page appears.

3. Under Actions, select Launch CloudFormation stack.

https://docs.aws.amazon.com/elasticloadbalancing/latest/application/introduction.html
https://docs.aws.amazon.com/elasticloadbalancing/latest/application/introduction.html
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4. On the Configure this Software page, under the Fulfillment option, select
CloudFormation Template from the first dropdown list.

5. From the second dropdown list, select the BYOL Jaspersoft Stack VPC deployment
for Jaspersoft Reporting and Analytics for AWS (BYOL).

6. Select the software version and under region, select either AWS GOVCloud(US) East
or AWS GOVCloud(US) West, then click Continue to Launch.

7. On Launch this software page, from Choose Action, select Launch CloudFormation
and then click Launch. AWS GovCloud(US) sign-in page opens. This page appears if a
user is not logged in to the GovCloud account.

Figure 8: AWS GovCloud(US) sign-in page

8. To sign in as an IAM user, enter Account ID, IAM username, and password and then
click Sign-in.

9. On the Create stack page, under Specify template, the Amazon S3 URL option is
already selected and a URL for the template file is filled in. Do not change these
options.

10.Click Next. The Specify stack details page appears.

11. In the Stack name field, give your CloudFormation stack a unique name.
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12.Choose an InstanceType.

13.Choose the KeyPairName of your EC2 KeyPair.

14.Choose the VpcId from your account.

15.Choose the SubnetId from the VPC.

16.Choose whether to create a publicly accessible IP address for the instance using
EnablePublicIp. Default is True. Select False to refuse.

17. In the RemoteAccessCIDR field, enter the IP address and mask for SSH access.

18.Click Next. The Configure stack options page appears.

19. In the Stack failure options section, select Preserve successfully provisioned
resources.

20.Click Next. The Review page appears.

21.Double-check your template, parameter, and option information.

22.Click the acknowledgment checkbox, then click Create Stack. You can see a message
telling you your stack has been created. The Services web page shows your stack's
initial status as CREATE_IN_PROGRESS. It generally takes two to four minutes for the
status to change to CREATE_COMPLETE.

23.Select your complete instance and click the Outputs tab. Here you can find
information you can need when you are ready to log into JasperReports Server:

• The URL for Getting Started with JasperReports Server.

• The name of your instance.

• The login name and password.

• The name of your S3LicenseBucket.

To create a new Gov Cloud cluster in a VPC

1. On the AWS Marketplace page, under the Get started section, click Manage
subscriptions to manage your subscriptions.

2. Select a Jaspersoft Reporting and Analytics for AWS (BYOL) subscription. Jaspersoft
Reporting and Analytics for AWS (BYOL) page appears.

3. Under Actions, select Launch CloudFormation stack.

4. On the Configure this Software page, under the Fulfillment option, select
CloudFormation Template from the first dropdown list.
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5. From the second dropdown list, select the Jaspersoft BYOL Cluster for Jaspersoft
Reporting and Analytics for AWS (BYOL).

6. Select the software version and under region, select either AWS GOVCloud(US) East
or AWS GOVCloud(US) West, then click Continue to Launch.

7. On Launch this software page, under Choose Action, select the Launch
CloudFormation and then click Launch. AWS GovCloud(US) sign-in page opens. This
page appears if a user is not logged in to the GovCloud account.

8. To sign in as an IAM user, enter Account ID, IAM username, and password and then
click Sign-in.

9. On the Create stack page, under Specify template, the Amazon S3 URL option is
already selected and a URL for the template file is filled in. Do not change these
options.

10.Click Next. The Specify stack details page appears.

11. In the Stack name field, give your CloudFormation stack a unique name.

12.Enter the host name of your database connection in DBHost, the database port
number in DBPort, and the database name in DBName.

13.Enter the database username in the DBUser field and the database password in
DBPassword.

14.Enter the Id of your existing RDSSecurityGroup in the RDSSecurityGroupId field.

15.Choose an InstanceType.

16.Choose the KeyPairName of your EC2 KeyPair.

17.Choose the VpcId from your account.

18.Choose the SubnetId from the VPC.

19.Choose whether to create a publicly accessible IP address for the instance using
EnablePublicIp. Default is True. Select False to refuse.

20. In the RemoteAccessCIDR field, enter the IP address and mask for SSH access.

21.Click Next. The Configure stack options page appears.

22. In the Stack failure options section, select Preserve successfully provisioned
resources.

23.Click Next. The Review page appears.

24.Double-check your template, parameter, and option information.
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25.Click the acknowledgment checkbox, then click Create Stack. You can see a message
telling you your stack has been created. The Services web page shows your stack's
initial status as CREATE_IN_PROGRESS. It generally takes two to four minutes for the
status to change to CREATE_COMPLETE.

26.Select your complete instance and click the Outputs tab. Here you can find
information you can need when you are ready to log into JasperReports Server:

• The URL for Getting Started with JasperReports Server.

• The name of your instance.

• The login name and password.

• The name of your S3LicenseBucket.
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Managing Your Installation
For information about the AWS data source, see the JasperReports Server Administrator
Guide.

This chapter contains the following sections:

• Applying a Jaspersoft License for AWS BYOL

• Using the Cloud Settings Page

• Upgrading Your Instance to Newer Version

• Retrieving Logs

• Stopping and Restarting Tomcat

Applying a Jaspersoft License for AWS BYOL
When creating your JasperReports Server instance or cluster for BYOL, AWS creates a S3
bucket for you to upload your JasperReports Server license. You need to upload your
license after the trial license expires.

More information on applying for a license is available on the Jaspersoft Community Site,
at http://community.jaspersoft.com/wiki/applying-your-jaspersoft-product-licenses.

Make sure you have all the prerequisites for applying for your license:

• A valid license file.

• Access to the AWS Management Console.

• A BYOL instance or cluster already running in AWS.

• A S3 bucket. You can find the name of the bucket on the Outputs tab of your
CloudFormation stack.

These instructions are only for BYOL licenses. You cannot upload other JasperReports Server
licenses to your S3 bucket.

If you are using a BYOL license for a cluster, deleting an instance before applying your license may
result in the automatic creation of a new instance using an older license.

http://community.jaspersoft.com/wiki/applying-your-jaspersoft-product-licenses
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To apply to your license file

1. Log in to the AWS console. The address is generally something like
https://<yourAWSAccountID>.signin.aws.amazon.com/console.

If you would like more information on logging into the AWS console see:
https://docs.aws.amazon.com/IAM/latest/UserGuide/console.html

2. On the AWS Management Console home page, click S3.

3. Click the name of the bucket for your instance or cluster.

4. Click Upload.

5. Click Add Files to find the license file on your local machine.

6. Click Start Upload.

AWS uploads the file and stores it in the S3 bucket.

7. With the license in place, reboot your instance from the EC2 > Instances > Instances
page.

To verify that your license is uploaded, open JasperReports Server in a web browser and
click About JasperReports Server in the lower left corner.

Figure 9: Valid License Information

Using the Cloud Settings Page
The cloud settings page enables you to change Security Group settings without restarting
the server. This page is accessible only if you are logged in as a superuser.

https://docs.aws.amazon.com/IAM/latest/UserGuide/console.html


Jaspersoft® AWS User Guide

30 | Managing Your Installation

To reach the AWS Settings page

1. Click Manage > Server Settings. The Log Settings page appears.

2. Click Cloud Settings in the left menu. The Cloud Settings page appears.

Figure 10: Cloud Settings Page

On this page you can enable AWS Security Group changes for the following settings:

• Access Rule Name

• Access Rule Description

• JasperReports Server Public IP

• Suppress EC2 Credentials Warning

There is one AWS DB Security Group (using IP address) in each RDS region, per JasperReports
Server instance. The security group allows connections from the JasperReports Server instance to
the specified AWS database instance.

Automatically Set Up an Access Rule for JasperReports Server: This checkbox is generally
left checked to allow JasperReports Server to use the instance credentials it assumes from
the IAM role or the Access\Secret keys provided in AWS Datasource to grant itself access to
RDS and Redshift data services. For example, let us say you stop your EC2 instance with
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JasperReports Server on Friday. When you restart it on Monday, the instance gets a new IP
address. JasperReports Server then re-grants itself access to RDS. If you want to manage
the security groups manually, clear this box.

Access Rule Name: JasperReports Server uses this security group name when creating
security groups to support AWS data sources. The EC2 instance ID is appended to this
name when your JasperReports Server instance is running on EC2. When running outside of
EC2, make sure that the security group name is unique for each instance of JasperReports
Server to ensure that IP addresses are properly granted access to the appropriate database
instances.

Access Rule Description: This text is the description of the security group or groups in the
AWS console.

JasperReports Server Public IP: Most users on EC2 should leave the field empty. On EC2,
JasperReports Server determines the IP address automatically. If you are running
JasperReports Server outside of EC2, determine your IP address and enter it in this field. It
is also possible with complex EC2 topology involving Virtual Private Clouds (VPCs) that you
need to provide your IP address manually.

Suppress EC2 Credentials Warning: If your JasperReports Server instance was created with
no IAM role, when you go to the data source wizard to add a data source with EC2
credentials you get a warning that no proper role is set. Checking this box suppresses the
warning and disables the option.

Upgrading Your Instance to Newer Version
To upgrade your JasperReports Server version to a newer one, go to the Jaspersoft
Community Wiki and follow the instructions.

Retrieving Logs

To retrieve logs

1. SSH into your instance using your AWS private key and the user name ec2-user.

a. To follow logs, execute this command:

tail -f /var/log/jasperserver/jasperserver.log

https://community.jaspersoft.com/wiki/jaspersoft-community-wiki-0
https://community.jaspersoft.com/wiki/jaspersoft-community-wiki-0
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b. To dump log content, execute this command:

cat /var/log/jasperserver/jasperserver.log

Stopping and Restarting Tomcat

To stop and restart Tomcat

1. SSH into your instance using your AWS private key and the username ec2-user.

2. Stop the Tomcat service using the following command:
sudo systemctl stop tomcat.socket

3. Restart the Tomcat service:
sudo systemctl start tomcat.socket
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Connecting to Your Data with JasperReports
Server
Follow the instructions in the chapter to connect JasperReports Server to Amazon RDS or
Redshift. For Amazon Elastic MapReduce (EMR) see Connect to Amazon EMR. For
connecting JasperReports Server to non-Amazon data sources, see Additional Connection
Types.

Launching JasperReports Server on AWS
Marketplace
On purchasing JasperReports Server on AWS Marketplace or obtaining your Bring Your Own
License (BYOL) key from Jaspersoft, make sure you follow the instructions in Applying a
Jaspersoft License for AWS BYOL to launch the product.

• If you purchase JasperReports Server directly on AWS Marketplace, the license key is
included.

• If you are using the Jaspersoft BYOL license key option, you can download the BYOL
license key from https://www.jaspersoft.com/support.

Prerequisites
You need to update your IAM role using the AWS CloudFormation console before you auto-
detect the Amazon Relational Database Server (RDS) and Amazon Redshift.

To add IAM role

1. Select JRSInstanceRole in the CloudFormation Resources tab.

2. Go to the Role > Edit JRSRolePolicy.

https://www.jaspersoft.com/support
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3. Select Redshift as a resource and then select add actions to add all the required
permissions one by one.

4. Add the resources by expanding the Resources section. You can either allow all
resources or provide the specific Amazon Resource Name(ARN).

Connect to Amazon RDS or Redshift
JasperReports Server can automatically discover and connect to Amazon Relational
Database Server (RDS) and Amazon Redshift using the auto-connect feature.

To connect to Amazon RDS or Redshift

1. Log into JasperReports Server as an administrator.

2. Go to Create > Data Source.

Figure 11: Create > Data Source menu

3. Select AWS Data Source from the Type dropdown menu.
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4. Enter your EC2 instance credentials. If EC2 instance credentials are not available,
then see the Additional Connection Possibilities section below.

5. Under AWS Settings, select EC2 instance credentials.

Figure 12: Add Data Source dialog

6. Enter your database connection info:

JasperReports Server is able to detect your RDS and Redshift data sources. This is
possible because the IAM Role associated with the EC2 instance is allowed to
execute the actions "rds:Describe*" and "redshift:Describe*". It pre-populates the
Database Name, Driver, and URL.

On the New Data Source page, You must enter the database username and
password. For security reasons, Amazon does not store these credentials, and
Jaspersoft cannot retrieve them.

The default database is automatically populated, but you may manually enter
another if your RDS or Redshift instance has multiple databases.
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Figure 13: New Data Source dialog

7. Test your connection:

You should always test your connection. This button does much more than just
testing:

• It creates a DB Security Group.

• It adds the internal IP of the EC2 instance to the security group to authorize
ingress to RDS.

This is possible because the IAM Role provides the instance with credentials like
"rds:CreateDBSecurityGroup" and
"redshift:AuthorizeClusterSecurityGroupIngress".
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• If you want to control details of the security group name or specify the IP
address manually because you have a complex VPC Topology, then navigate to
the menu Manage > Server Settings > AWS Settings.

Figure 14: Test Connection dialog

8. Create a Domain:

Jaspersoft's metadata layer is called "Data Domains". Choose Create > Domain from
the main menu and follow the wizard to build a domain.
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Figure 15: Create > Domain menu

9. Analyze your data:

Choose Create > Ad Hoc View. Find your newly created domain and use the ad hoc
environment to begin analyzing your data.
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Figure 16: Create > Ad Hoc View menu

10.Next steps:

Refer to the Online Learning Portal for details on creating domains, performing ad
hoc analysis, and creating reports.

Additional Connection Types
• AWS Credentials

We recommend launching Jaspersoft BI on an EC2 instance with an associated IAM
Role. This role provides EC2 credentials for your JasperReports Server instance.

If this option is not available, you can use AWS credentials instead. If you already
have AWS Credentials, you can enter the Access Key and Secret Key.

https://www.jaspersoft.com/bi-training-center
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Figure 17: Entering AWS credentials

• JDBC / JNDI Connections

NOTE: When using JDBC for data source connections, you are responsible for managing the
security groups to allow access from the Jaspersoft server to the data source.
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Figure 18: Using JDBC / JNDI connections

• Amazon RDS or Redshift

When connecting to Amazon RDS or Redshift, it is best to use the AWS Data Source
type to make configuration easier. If you prefer, you can use JDBC to connect to
Amazon RDS or Redshift. To connect using JDBC, choose the JDBC Data Source type.
Enter all connection information and test. Alternatively, you can choose JNDI Data
Source and refer to a data source defined in Apache Tomcat.

Benefits of defining your own JDBC connections

• You have complete control

Benefits of using AWS Data Sources

• Jaspersoft provides the driver and URL
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• Data source automatically recovers if the IP address changes

• Data source automatically recovers if DB Security Groups are modified

Connect to Amazon EMR
The JasperReports Server auto-connect feature is not supported for Amazon EMR.
Connections to EMR need to be configured manually. Please see the Amazon EMR
connection page for details: http://community.jaspersoft.com/jaspersoft-aws/connect-emr

http://community.jaspersoft.com/jaspersoft-aws/connect-emr
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Working With Jaspersoft Studio Professional
Jaspersoft Studio enables you to create sophisticated, pixel-perfect reports on the desktop
and upload those reports to JasperReports Server on AWS. Jaspersoft Studio allows you to
create sophisticated layouts containing charts, images, subreports, crosstabs, and more.

Downloading Jaspersoft Studio
Jaspersoft Studio is available as an Eclipse Rich Client Package (RCP), downloadable from
the following location: http://community.jaspersoft.com/project/jaspersoft-studio/releases.

See the Jaspersoft Studio User Guide for instructions on how to install Jaspersoft Studio
on your local machine and installing your license.

Connecting Jaspersoft Studio to Your Data
1. To create a new Data Adapter (called Data Source in Jaspersoft Studio), in

Jaspersoft Studio, click the Create Data Adapter icon to display the Data Adapter
Wizard.

Figure 19: Create Data Adapter button

2. Select the data source type. For Amazon RDS and Redshift, use JDBC. Then click
Next.

http://community.jaspersoft.com/project/jaspersoft-studio/releases
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Figure 20: Selecting a data source type

3. Add the JDBC Driver. You may need to search the web for one that corresponds to
your RDBMS or other technology on your EC2 instance.

Figure 21: Entering your database location
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4. Enter the JDBC Url. This is the Endpoint URL from your Amazon EC2 dashboard
(including the port) and database type.

Figure 22: Locating the Endpoint

5. Click the Driver Classpath tab and select the local path of the driver.
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Figure 23: Selecting the driver classpath

6. Test the connection.

Connecting Jaspersoft Studio Pro to the
JasperReports Server Repository
You need to connect to the Jaspersoft Studio repository to manage and schedule reports

To define the Repository Explorer's connection

1. In Jaspersoft Studio, select Window > Show Views > Other….
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Figure 24: Window > Show Views > Other…. menu

2. Select Repository Explorer.
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Figure 25: Selecting the Repository Explorer

3. Select the instance’s URL. It should start with ec2.
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Figure 26: Selecting the instance URL

4. Right-click the name of your instance to create a JasperReports Server repository
connection.

Figure 27: Creating the JasperReports Server repository connection
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5. Fill in the instance’s url, but don’t add the port ID number. Make sure to include
/jasperserver-pro/ at the end of the path.

Figure 28: Filling in the instance URL

From here you should follow the Jaspersoft Studio documentation on how to create
reports. There is also online training and tutorials available here:

http://community.jaspersoft.com/wiki/jaspersoft-studio-tutorials-archive

http://community.jaspersoft.com/wiki/jaspersoft-studio-tutorials-archive
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Amazon Terminology
Amazon Machine Image (AMI)

A supported and maintained Linux provided by Amazon Web Services for use on Amazon
Elastic Compute Cloud (Amazon EC2). It is designed to provide a stable, secure, and high-
performance execution environment for applications running on Amazon EC2. It also
includes several packages that enable easy integration with AWS, including launch
configuration tools and many popular AWS libraries and tools. Amazon Web Services also
provides ongoing security and maintenance updates to all instances running the Amazon
AMI.

Amazon Web Services (AWS)

Cloud platform, used to provide and host a family of services, such as RDS, S3, EC2,
DynamoDB.

AWS Console

The user interface Amazon has built around the available services offered. Within the AWS
Console, there are sub-consoles for individual services (EC2, S3, RDS, CloudFront,
DynamoDB, and so on)

AWS Marketplace

Storefront for commercial AMIs provided and managed by Amazon, which bills customer
for usage and keeps a percentage of sales proceeds.

AWS Identity and Access Management (IAM)

AWS Identity and Access Management (IAM) enables you to create multiple users and
manage the permissions for each of these users within your AWS Account. A user is an
identity within your AWS account with unique security credentials that can be used to
access AWS Services. IAM eliminates the need to share passwords or access keys, and
makes it easy to enable or disable a user’s access as appropriate.

CloudFormation (CF)

AWS CloudFormation gives developers and systems administrators an easy way to create
and manage a collection of related AWS resources, provisioning and updating them in an
orderly and predictable fashion.
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Marketplace AMI

An AMI that is distributed through the AWS Marketplace.

Public AMI

AMI is configured as public by any Amazon user, and listed in everyone's AWS EC2 console
AMI area.

RDS

Amazon's Relational Database Service, which makes it easy to run MySQL, Oracle, or SQL
Server database servers in the cloud. The servers are managed, upgraded, and backed up
by Amazon.

Stack

A collection of AWS resources you create and delete as a single unit
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Jaspersoft Documentation and Support
Services
For information about this product, you can read the documentation, contact Support, and
join Jaspersoft Community.

How to Access Jaspersoft Documentation

Documentation for Jaspersoft products is available on the Product Documentation website,
mainly in HTML and PDF formats.

The Product Documentation website is updated frequently and is more current than any
other documentation included with the product.

Product-Specific Documentation

The documentation for this product is available on the Jaspersoft® Product Documentation
page.

How to Access Related Third-Party Documentation

When working with Jaspersoft®, you may find it useful to read the documentation of the
following third-party products:

How to Contact Support for Jaspersoft Products

You can contact the Support team in the following ways:

l To access the Support Knowledge Base and getting personalized content about
products you are interested in, visit our product Support website.

l To create a Support case, you must have a valid maintenance or support contract
with a Cloud Software Group entity. You also need a username and password to log
in to the product Support website. If you do not have a username, you can request
one by clicking Register on the website.

https://community.jaspersoft.com/documentation/
https://community.jaspersoft.com/documentation/
https://community.jaspersoft.com/documentation/
https://www.jaspersoft.com/support
https://www.jaspersoft.com/support
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How to Join Jaspersoft Community

Jaspersoft Community is the official channel for Jaspersoft customers, partners, and
employee subject matter experts to share and access their collective experience. Jaspersoft
Community offers access to Q&A forums, product wikis, and best practices. It also offers
access to extensions, adapters, solution accelerators, and tools that extend and enable
customers to gain full value from Jaspersoft products. In addition, users can submit and
vote on feature requests from within the Jaspersoft Ideas Portal. For a free registration, go
to Jaspersoft Community.

https://jaspersoftideas.tibco.com/
https://community.jaspersoft.com/
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Legal and Third-Party Notices
SOME CLOUD SOFTWARE GROUP, INC. (“CLOUD SG”) SOFTWARE AND CLOUD SERVICES EMBED,
BUNDLE, OR OTHERWISE INCLUDE OTHER SOFTWARE, INCLUDING OTHER CLOUD SG SOFTWARE
(COLLECTIVELY, “INCLUDED SOFTWARE”). USE OF INCLUDED SOFTWARE IS SOLELY TO ENABLE THE
FUNCTIONALITY (OR PROVIDE LIMITED ADD-ON FUNCTIONALITY) OF THE LICENSED CLOUD SG
SOFTWARE AND/OR CLOUD SERVICES. THE INCLUDED SOFTWARE IS NOT LICENSED TO BE USED OR
ACCESSED BY ANY OTHER CLOUD SG SOFTWARE AND/OR CLOUD SERVICES OR FOR ANY OTHER
PURPOSE.

USE OF CLOUD SG SOFTWARE AND CLOUD SERVICES IS SUBJECT TO THE TERMS AND CONDITIONS
OF AN AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED AGREEMENT, OR, IF THERE IS NO
SUCH SEPARATE AGREEMENT, THE CLICKWRAP END USER AGREEMENT WHICH IS DISPLAYED WHEN
ACCESSING, DOWNLOADING, OR INSTALLING THE SOFTWARE OR CLOUD SERVICES (AND WHICH IS
DUPLICATED IN THE LICENSE FILE) OR IF THERE IS NO SUCH LICENSE AGREEMENT OR CLICKWRAP
END USER AGREEMENT, THE LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF THE SOFTWARE. USE
OF THIS DOCUMENT IS SUBJECT TO THOSE SAME TERMS AND CONDITIONS, AND YOUR USE HEREOF
SHALL CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE BOUND BY THE SAME.

This document is subject to U.S. and international copyright laws and treaties. No part of this
document may be reproduced in any form without the written authorization of Cloud Software
Group, Inc.

Jaspersoft, JasperReports, Visualize.js, and TIBCO are either registered trademarks or trademarks of
Cloud Software Group, Inc. in the United States and/or other countries.

All other product and company names and marks mentioned in this document are the property of
their respective owners and are mentioned for identification purposes only. You acknowledge that all
rights to these third party marks are the exclusive property of their respective owners. Please refer to
Cloud SG’s Third Party Trademark Notices (https://www.cloud.com/legal) for more information.

This document includes fonts that are licensed under the SIL Open Font License, Version 1.1, which is
available at: https://scripts.sil.org/OFL

Copyright (c) Paul D. Hunt, with Reserved Font Name Source Sans Pro and Source Code Pro.

Cloud SG software may be available on multiple operating systems. However, not all operating
system platforms for a specific software version are released at the same time. See the “readme” file
for the availability of a specific version of Cloud SG software on a specific operating system platform.

https://www.cloud.com/legal
https://scripts.sil.org/OFL
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THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS. CHANGES
ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL BE INCORPORATED
IN NEW EDITIONS OF THIS DOCUMENT. CLOUD SG MAY MAKE IMPROVEMENTS AND/OR CHANGES IN
THE PRODUCT(S), THE PROGRAM(S), AND/OR THE SERVICES DESCRIBED IN THIS DOCUMENT AT ANY
TIME WITHOUT NOTICE.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE, INCLUDING BUT
NOT LIMITED TO ANY RELEASE NOTES AND "README" FILES.

This and other products of Cloud SG may be covered by registered patents. For details, please refer
to the Virtual Patent Marking document located at https://www.tibco.com/patents.

Copyright © 2005-2024. Cloud Software Group, Inc. All Rights Reserved.

https://www.tibco.com/patents
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